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Bevor Sie einschalten ...

Wir wiinschen lhnen viel SpaB mit Inrem neuen Geréat von ,img Stage
Line“. Bitte lesen Sie diese Bedienungsanleitung vor dem Betrieb
grindlich durch. Nur so lernen Sie alle Funktionsmdglichkeiten ken-
nen, vermeiden Fehlbedienungen und schiitzen sich und Ihr Gerét
vor eventuellen Schaden durch unsachgeméaBen Gebrauch. Heben
Sie die Anleitung fiir ein spateres Nachlesen auf.

Der deutsche Text beginnt auf der Seite 4.

Before switching on ...

We wish you much pleasure with your new “img Stage Line” unit.
Please read these operating instructions carefully prior to operating
the unit. Thus, you will get to know all functions of the unit, operating
errors will be prevented, and yourself and the unit will be protected
against any damage caused by improper use. Please keep the oper-
ating instructions for later use.

The English text starts on page 16.

www.imgstageline.com
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1 Einsatzmoéglichkeiten

Die LED-Anzeige kann auf einer Matrix von 7 x 80
LEDs Texte und einfache Bilder darstellen. Durch
die RGB-LEDs sind Darstellungen in den Grund-
farben Rot, Griin und Blau sowie in den Mischfar-
ben Gelb, Cyan, Magenta und WeiB mdglich. Die
Bedienung erfolgt Uber die mitgelieferte Infrarot-
Fernbedienung oder per USB Uber einen Compu-
ter. Es kénnen 26 Nachrichten in der Anzeige
gespeichert werden. Diese lassen sich in beliebiger
Reihenfolge kombinieren und mit verschiedenen
Aufmerksamkeit erregenden Effekten anzeigen.
Uber die eingebaute Uhr ist auch eine zeitgesteu-
erte Anzeige oder die Anzeige von Datum und Uhr-
zeit moglich. Eine interne Puffer-Batterie erhélt die
eingegebenen Daten und lasst die Uhr bei getrenn-
ter Stromversorgung weiterlaufen. Das mitgelie-
ferte PC-Programm ermdglicht zuséatzlich das
Erstellen eigener Bilder und Sonderzeichen.

2 Hinweise fiir den
sicheren Gebrauch

Die Gerate (Anzeige und Netzgerat) entsprechen
allen relevanten Richtlinien der EU und sind des-
halb mit C€ gekennzeichnet.

WARNUNG Das Netzgerat wird mit lebensge-
fahrlicher Netzspannung versorgt.
Nehmen Sie deshalb niemals selbst
Eingriffe daran vor. Durch unsachge-
maBes Vorgehen besteht die Gefahr
eines elektrischen Schlages.
Beachten Sie auch unbedingt folgende Punkte:

® Die Gerate sind nur zur Verwendung im Innen-
bereich geeignet. Schiitzen Sie sie vor Tropf-
und Spritzwasser, hoher Luftfeuchtigkeit und
Hitze (zuléssige Einsatztemperatur 0—40 °C).

® Nehmen Sie die Anzeige nicht in Betrieb und zie-

hen Sie sofort den Netzstecker aus der Steck-

dose,

1. wenn sichtbare Schaden an den Geraten oder
am Netzkabel vorhanden sind,

2.wenn nach einem Sturz oder Ahnlichem der
Verdacht auf einen Defekt besteht,

3. wenn Funktionsstérungen auftreten.

Geben Sie die Gerate in jedem Fall zur Repara-

tur in eine Fachwerkstatt.

® Ziehen Sie den Netzstecker nie am Kabel aus
der Steckdose, fassen Sie immer am Stecker an.

® Verwenden Sie fur die Reinigung nur ein trocke-
nes, weiches Tuch, niemals Wasser oder Che-
mikalien.

® Werden die Gerate zweckentfremdet, nicht rich-
tig angeschlossen, falsch bedient oder nicht
fachgerecht repariert, kann keine Haftung fir
daraus resultierende Sach- oder Personenschéa-
den und keine Garantie fur die Gerate libernom-
men werden. Ebenso kann keine Haftung fur
durch Fehlbedienung oder durch einen Defekt
entstandene Datenverluste und deren Folge-
schaden Gbernommen werden.

hid

Sollen die Gerate endgiltig aus dem
Betrieb genommen werden, Uubergeben
Sie sie zur umweltgerechten Entsorgung
einem Ortlichen Recyclingbetrieb.

3 Inbetriebnahme

3.1 Montage

Um die Anzeige z.B. an einer Wand zu montieren,
die beiliegenden Montagewinkel (2) verwenden.
Die Winkel wie in Abbildung 1 mit jeweils zwei der
beiliegenden Schrauben an der Anzeige befestigen.

WARNUNG Die Anzeige muss fachgerecht und
sicher montiert werden. Wird sie an
einer Stelle installiert, unter der sich
Personen aufhalten kénnen, muss

die Befestigung gegen Selbstlésen

gesichert sein oder ein Herabfallen
durch eine zusatzliche Sicherung
verhindert werden.

3.2 Batterien in die Fernbedienung
einsetzen

Das Batteriefach der Fernbedienung befindet sich

auf der Unterseite.

1) Den Batteriefachdeckel entfernen.

2) Zwei Batterien der GroBe Micro (AAA) einset-
zen. Dabei die Polung beachten (Ausrichtung
der Batterien wie im Batteriefach gezeigt).

3) Das Batteriefach mit dem Deckel verschlieBen.

3.3 Computer anschlieBen

Soll die Anzeige liber einen Computer ferngesteu-
ert oder eingerichtet werden, diesen Uber das bei-
liegende Adapterkabel anschlieBen. Den Klinken-
stecker an die Buchse (3) der Anzeige, den
USB-Stecker an eine USB-Buchse des Computers
anschlieBen.

Hinweis: Um Ubertragungsfehler zu vermeiden, fir das
USB-Kabel bei Bedarf nur Verldangerungen mit Signalver-
starkung verwenden.
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3.4 Netzanschluss

Den Kleinspannungsstecker des beiliegenden Netz-
geréates mit der Niederspannungsbuchse (1) verbin-
den und das Netzgeréat Uber das Netzkabel mit
einer Steckdose (230 V~/50 Hz). Damit ist die An-
zeige eingeschaltet. Sie zeigt kurz aufeinander fol-
gend Systeminformationen an und wechselt dann
zur Anzeige der zuletzt gewéhlten Nachricht.

3.5 PC-Software installieren
Systemvoraussetzung fir die Installation des mit-
gelieferten Steuerprogramms ist ein PC mit dem
Betriebssystem Windows 98, Windows ME, Wind-
ows NT, Windows 2000, Windows XP oder héher,
einem Arbeitsspeicher von mindestens 32 MB und
einer USB-Schnittstelle. Fur die Installation der PC-
Software die mitgelieferte CD einlegen und bei der
automatisch erscheinenden BegriiBung ,Welcome*
auf den Punkt ,Install Software® klicken. Erscheint
diese BegriiBung nicht, das Installationsprogramm
SETUP.EXE auf der CD starten. AnschlieBend den
Anweisungen des Installationsprogramms folgen.

Windows ist ein registriertes Warenzeichen der Microsoft Corporation in den USA
und anderen Léndern.

3.5.1 USB-Treiber installieren

Fur die Anbindung tber die USB-Schnittstelle wird
ein spezieller Treiber benétigt, der fur das Steuer-
programm eine serielle Schnittstelle simuliert. Ist
auf dem Computer kein geeigneter Treiber instal-
liert, diesen von der beiliegenden CD installieren.

4 Bedienung

Die Anzeige lasst sich Uber die mitgelieferte Infra-
rot-Fernbedienung bedienen oder Uber einen Com-
puter, auf dem das mitgelieferte Steuerprogramm
installiert ist. Dabei bietet das Steuerprogramm
einige Zusatzfunktionen, wie z.B. das Erstellen
eigener Bilder oder Sonderzeichen.

4.1 Bedienung uber die IR-Fernbedienung
Zum Bedienen der Anzeige Uber die mitgelieferte
Infrarot-Fernbedienung diese auf den Infrarot-Sen-
sor rechts vom LED-Feld ausrichten. Die Anzeige
quittiert jedes von der Fernbedienung empfangene
Kommando mit einem Piepton, wenn der Ton nicht
ausgeschaltet wurde (i=° Kap. 4.1.7.5).

4.1.1 Ein-/Ausschalten

Nach dem Anschluss an die Stromversorgung ist
die Anzeige immer eingeschaltet. Um sie mit der
Fernbedienung auszuschalten oder wieder einzu-
schalten, die Taste [ON/OFF] driicken.

4.1.2 Datum und Uhrzeit anzeigen

Um anstatt einer Nachricht das aktuelle Datum und
die Uhrzeit im Wechsel anzuzeigen, die Taste
[TIME/DATE] dricken. Fur die Rickkehr zur
Anzeige der Nachricht die Taste [ESC] drlicken.

Zur Einstellung von Datum und Uhrzeit 1= Kap. 4.1.7.1.

4.1.3 Schnelleingabe eines Textes

Fur die schnelle, unkomplizierte Eingabe einer ein-
zelnen Textzeile:

1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

2) Die Taste [Q-PROG] dricken. Es wird kurz
,QUICK PAGE EDIT" angezeigt.

3) Den Text eingeben (1= Kap. 4.1.3.1).

4) Die Eingabe mit [ENTER] abschlieBen. Der ein-
gegebene Text lauft jetzt automatisch Uber die
Anzeige.

4.1.3.1 Texteingabe
Eine Texteingabe (max. 210 Zeichen) erfolgt Gber
die Buchstabentasten [A] bis [Z]. Uber die Taste
[SHIFT] kann zwischen GroBbuchstaben (Cursor-
Darstellung: ,1), Kleinbuchstaben (,1%), Ziffern/
Sonderzeichen (Tastenbeschriftung weiB, “I,) und
weiteren Sonderzeichen (Tastenbeschriftung griin,
“l,) umgeschaltet werden.

Fur einige Buchstaben stehen Varianten zur
Auswahl. Diese kénnen nach der Eingabe des



Buchstabens uber (wiederholtes) Driicken der
Taste [EUROP-CHAR] ausgewahlt werden:

Buchstabe Varianten Buchstabe | Varianten
A AAARAAE a ddadade
B B
C C c c
D b
E EEEE e [X-1-X:
I i i Vit
N N n fi
o 00606066 o 06686
P P p o]

9] uuou uaau
Y vy y vy

Hinweis: Mithilfe der PC-Software kénnen die Varianten
auch durch eigene Zeichen ersetzt werden, die dann auch
Uber die Fernbedienung abgerufen werden kénnen.

Zum Einfugen eines Leerzeichens [SPACE], zum
Ldschen des letzten Zeichens [DEL] driicken.

Mit [FONT] kann der Schriftstil (normal: 5x7,
schmal: 4 x 7 oder fett: 6 x 7 = Bildpunkte pro Zei-
chen: horizontal x vertikal) gewechselt werden, mit
[COLOR] die Textfarbe.

4.1.4 Texte mit Effekten speichern

Es lassen sich 26 Texte jeweils mit Ein- und
Ausblendeffekt, Anzeigedauer und Bewegungsge-
schwindigkeit als Nachricht in der Anzeige spei-
chern. Diese kénnen anschlieBend einzeln ange-
zeigt oder in beliebiger Reihenfolge kombiniert
werden.

1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

Die Taste [PROG] driicken. Es wird kurz ,PRO-
GRAM* und dann ,EDIT PAGE?“ angezeigt.
[ENTER] driicken. Es wird ,EDIT PAGE: A“
angezeigt.

Mit [1] oder [{] den Speicherplatz wéhlen (A bis
Z) und mit [ENTER] bestatigen. Es wird jetzt

z.B. ,B]I_EFF" angezeigt, wenn der Speicher-
platz B gewahlt wurde.

Hinweis: Der Speicherplatz A wird bei der Schnellein-
gabe (1= Kap. 4.1.3) Uberschrieben.

Mit [1] oder [{] den Einblendeffekt (I_EFF) wéah-
len.

2

L b

-

o

Folgende Einblendeffekte stehen zur Auswahl:

Immediate Text wird ohne Effekt sofort gezeigt

Open Einblendung von der Mitte zu den
Ecken

Curtain Up Einblendung von unten nach oben

Curtain Down Einblendung von oben nach unten

Scroll Left Hereinlaufen von rechts nach links

Scroll Right Hereinlaufen von links nach rechts

Vopen Einblendung von der Mitte nach
oben und unten

Vclose Einblendung von oben und unten
zur Mitte

Scroll Up Hereinlaufen von unten nach oben

Scroll Down Hereinlaufen von oben nach unten

Curtain Left Einblendung von rechts nach links

Curtain Right Einblendung von links nach rechts

Snow wie Schnee von oben hereinfal-
lende Punkte

Twinkle Funkeleffekt mit durchlaufenden
Wellen oder Farben

Block Move Hereinlaufen von rechts in Blécken

Random zufélliges Erscheinen der einzelnen

Punkte

Hinweis: Ist ein Text breiter als die Anzeige, kann er
mit dem Einblendeffekt ,Scroll Left” vollstdndig gezeigt
werden.

2

Mit [] zur Einstellung der Anzeigedauer wech-
seln. Es wird jetzt z. B. ,B]STAY : 02 Sec* ange-
zeigt. Mit [1] oder [{] die Anzeigedauer (0O bis
25 s) fir den Text wahlen.

Mit [«] kann zur vorherigen Eingabe zurlckge-
wechselt werden, mit [ESC] lasst sich der Ein-
stellvorgang jederzeit abbrechen.

7) Mit [=] zur Einstellung der Ablaufgeschwindig-
keit wechseln. Es wird jetzt z. B. ,B]SPEED:2"
angezeigt. Mit [T] oder [{] die Ablaufgeschwin-
digkeit (1 bis 4) flr die Effekte wahlen.

8) Mit [-] zur Einstellung der Anzeigeart wech-
seln. Es wird jetzt z.B. ,BJ]MODE :Normal*
angezeigt. Mit [1] oder [{] wahlen, ob der Text
blinkend (Blink) angezeigt werden soll oder
nicht (Normal).

9) Mit [-] zur Einstellung des Ausblendeffektes
wechseln. Es wird jetzt z. B. ,BJO_EFF:Imme-
diate” angezeigt. Mit [1] oder [{] den Ausblend-
effekt wahlen.

Folgende Ausblendeffekte stehen zur Auswahl:

Immediate Text verschwindet ohne Effekt

Open/Close Ausblendung von der Mitte zu den
Ecken

Curtain Up Ausblendung von unten nach oben

Curtain Down Ausblendung von oben nach unten

Scroll Left Hinauslaufen nach links

Scroll Right Hinauslaufen nach rechts

Vopen Ausblendung von der Mitte nach
oben und unten

Vclose Ausblendung von oben und unten
zur Mitte

Scroll Up Herauslaufen nach oben

Scroll Down Herauslaufen nach unten

Curtain Left Ausblendung von rechts nach links

Curtain Right Ausblendung von links nach rechts

Hold Text bleibt stehen

10) Die Taste [ENTER] driicken. Es wird kurz z. B.
.Page B Content” angezeigt. AnschlieBend
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kann der gewunschte Text eingegeben werden
(r=> Kap. 4.1.3.1).

11) Die Taste [ENTER] dricken. Die Nachricht ist
jetzt gespeichert und kann angezeigt werden
(r=° Kap. 4.1.5)

4.1.5 Nachrichten anzeigen
Um eine oder mehrere zuvor gespeicherte Nach-
richten anzuzeigen:

1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

2) Die Taste [RUN-PAGE] driicken. Es wird kurz
+,EDIT RUN PAGE" angezeigt.

3) Mit den Tasten [A] bis [Z] die Speicherplatze der
Nachrichten in der fir die Anzeige gewuinschten
Reihenfolge eingeben. Eine falsche Eingabe
kann mit [DEL] korrigiert werden.

4) Die Eingabe mit [ENTER] abschlieen.

Alle gewéhlten Nachrichten werden zunéachst kurz
angezeigt und erscheinen dann wiederholt geman
ihren gespeicherten Parametern. Enthalt ein ge-
wahlter Speicherplatz keine Nachricht, erscheint
eine Fehlermeldung ,EMPTY PAGE".

4.1.6 Zeitgesteuerte Anzeige

Gespeicherte Nachrichten kdnnen automatisch zu
festgelegten Zeiten Uber finf unabhéangige Pro-
gramme angezeigt werden. Zum Erstellen eines
Programms:

1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

2) Die Taste [PROG] driicken. Es wird kurz ,PRO-
GRAM* und dann ,EDIT PAGE?“ angezeigt.

3) Mit [{] zu ,,EDIT SCHEDULE?“ wechseln und
mit [ENTER] bestétigen. Es wird ,EDIT SCHE-
DULE:1* angezeigt.

4) Mit [1] oder [{] den Speicherplatz wéhlen (1 bis
5) und mit [ENTER] bestatigen. Es wird z.B.
L2]START YEAR :13“ angezeigt, wenn der Spei-
cherplatz 2 gewahlt wurde.

5) Mit [1] oder [{] die Jahreszahl fir die Startzeit
einstellen.

6) Mit [] zum Monat fur die Startzeit ,START
MONTH* wechseln und diesen mit [1] oder [{]
einstellen.

Auf die gleiche Weise den Tag ,START DAY*,
die Stunde ,START HOUR* und die Minute
LSTART MIN. fur die Startzeit eingeben.

Dann ebenso mit dem Jahr ,STOP YEARY,
dem Monat ,STOP MONTH", dem Tag ,STOP
DAY*, der Stunde ,STOP HOUR® und der
Minute ,STOP MIN.“ den Zeitpunkt eingeben,

bis zu dem einschlieBlich die Anzeige erfolgen
soll.

Mit [«] kann jeweils zur vorherigen Eingabe
zurtickgewechselt werden, mit [ESC] lasst sich
der Einstellvorgang jederzeit abbrechen.

7) Die Taste [ENTER] driicken. Es wird kurz ,Dis-
play Pages” angezeigt. AnschlieBend mit den
Tasten [A] bis [Z] die Speicherplatze der Nach-
richten in der fUr die Anzeige gewtinschten Rei-
henfolge eingeben. Eine falsche Eingabe kann
mit [DEL] korrigiert werden.

8) Die Eingabe mit [ENTER] abschlieBen.

4.1.7 Systemeinstellungen

4.1.7.1 Datum und Uhrzeit einstellen

1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

2) Die Taste [FUNCT] dricken. Es wird kurz
»,LFUNCTION® und dann ,CLEAR ALL" ange-
zeigt.

3) [{] so oft driicken, bis z. B. ,YEAR" (fur die Ein-
stellung der Jahreszahl) angezeigt wird.

4) [ENTER] dricken.

5) Die Einstellung mit [1] oder [{] &ndern und mit
[ENTER] bestétigen.

Die Schritte 2) bis 5) nach Bedarf wiederholen und
in Schritt 3) entsprechend den Monat ,MONTH",
den Tag ,DAY*, die Stunde ,HOUR" oder die Minute
LMINUTE" wéhlen.

Die Einstellung kann jederzeit mit [ESC] abgebro-
chen werden.

4.1.7.2 Helligkeit &ndern

1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

2) Die Taste [FUNCT] dricken. Es wird kurz
»,LFUNCTION® und dann ,CLEAR ALL"“ ange-
zeigt.

3) [{] so oft driicken, bis ,BRIGHTNESS" ange-
zeigt wird.

4) [ENTER] dricken.

5) Mit [1] oder [{] die Helligkeit wahlen:
4=100%,3=75%,2=50%,1=25%

Die Eingabe mit [ENTER] bestétigen.

Die Einstellung kann jederzeit mit [ESC] abgebro-

chen werden.

4.1.7.3 Geréte-Adresse (ID) &ndern

Zur Unterscheidung mehrerer Geréate kann jedem
eine eigene ID-Nummer/Adresse zugewiesen wer-
den.



1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

2) Die Taste [FUNCT] dricken. Es wird kurz
LFUNCTION® und dann ,CLEAR ALL® ange-
zeigt.

3) [{] so oft driicken, bis ,SET ID* angezeigt wird.

4) [ENTER] dricken. Die aktuelle Adresse wird
angezeigt, z.B. ,SET ID : 01“

5) Mit [T] oder [{] die Adresse (hexadezimal) ein-
stellen. Die Eingabe mit [ENTER] bestatigen.

Die Einstellung kann jederzeit mit [ESC] abgebro-
chen werden.

4.1.7.4 Alle Nachrichten und Programme ldschen

Alle vom Benutzer gespeicherten Nachrichten und

Anzeige-Programme kénnen mit der folgenden

Funktion geldscht werden.

1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

2) Die Taste [FUNCT] dricken. Es wird kurz
4FUNCTION® und dann ,CLEAR ALL“ ange-
zeigt.

3) [ENTER] dricken. Es wird ,CLEAR ALL:NO“
angezeigt.

4) Mit [{] zu ,CLEAR ALL:YES" wechseln.

5) Das Léschen mit [ENTER] bestétigen oder den
Vorgang mit [ESC] abbrechen.

Der anschlieBend auf dem Speicherplatz A ange-
zeigte Werbetext kann einfach wieder mit einer
eigenen Nachricht Giberschrieben werden (15> Kap.
4.1.3 und 4.1.4).

4.1.7.5 Tasten-Piepton aus- oder einschalten

Wenn gewdlnscht, quittiert die Anzeige jedes von
der Fernbedienung empfangene Kommando mit
einem Piepton.

1) Ist die Anzeige von Datum und Uhrzeit aktiv,
diese mit [ESC] beenden.

2) Die Taste [FUNCT] dricken. Es wird kurz
4FUNCTION“ und dann ,CLEAR ALL“ ange-
zeigt.

3) [{] so oft driicken, bis ,KEY SOUND" angezeigt
wird.

4) [ENTER] dricken. Es wird z.B. ,KEY SOUND:
NO* angezeigt.

5) Mit [1] oder [{] den Piepton einschalten (YES)
oder ausschalten (NO).

6) Die Einstellung mit [ENTER] bestatigen oder
den Vorgang mit [ESC] abbrechen.

4.2 Bedienung liber einen Computer

Das Steuerprogramm ,Multi-color Sign[...].EXE" auf
dem PC starten. Das Hauptfenster (1= Abb. 2) wird
angezeigt.

0=

File Edit Commands Europesn Font Caolor  Bmp Graphics  Functions Help
= .
D tB2@R g 3
Line 1

< Open><Fontix7>Text - text - texte -
<Magenta>testo - texto - tekst <U29>
<Scroll Up=>

57

@ Hauptfenster mit Text

4.2.1 Schnittstelle einstellen

Bevor das Programm Daten an die Anzeige uber-
tragen kann, muss die richtige Schnittstelle gewahit
werden.

1) Den Mentpunkt File » Set COM... aufrufen und
aus der Liste die Nummer der Schnittstelle wah-
len, die vom USB-Treiber fir das Programm
simuliert wird.

Die betreffenden Einstellungen des Betriebs-
systems sind z.B. zu finden unter » System-
steuerung #» Systemeigenschaften (Hardware)
» Gerate-Manager » Anschlisse (COM und
LPT).

Dort steht z. B.: ,USB to UART [...] (COM3)*

Wurde der Schnittstelle vom Computer eine
héhere COM-Nummer als 8 zugeteilt, muss
diese manuell auf eine COM-Nummer von 1 bis
8 geéndert werden (z. B. Uber # Eigenschaften
» Anschlusseinstellungen » Erweitert...).

Die Ubertragungsparameter missen fir die
Schnittstelle folgendermaBen eingestellt sein
(z. B. Uber » Eigenschaften » Anschlusseinstel-
lungen):

Bits pro Sekunde: 9600

Datenbits: 8
Paritat: Keine
Stoppbits: 1

Flusssteuerung:  Xon/Xoff
2) Die Eingabe mit ,OK" bestatigen.

4.2.2 Nachricht eingeben und

zur Anzeige Ulbertragen
Einen anzuzeigenden Text in das Textfenster
(1= Abb. 2) eingeben. Am unteren Rand wird die
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Anzahl der im Fenster befindlichen Zeichen ange-
zeigt. Bei dem Versuch, mehr als 210 Zeichen ein-
zugeben erscheint eine Meldung, dass das Maxi-
mum erreicht ist.

Uber das Menti lassen sich in den Text Forma-
tierungsanweisungen (1= Kap. 4.2.3), Sonderzei-
chen (1= Kap. 4.2.4), Datum und Uhrzeit (i=> Kap.
4.2.5), Bilder (1= Kap. 4.2.6) oder Einblend-, Aus-
blend- oder Anzeige-Effekte (1=° Kap. 4.2.7) einfi-
gen. Diese werden jeweils in roter Schrift in spitzen
Klammern dargestellt und haben Einfluss auf die
Art, wie der Text angezeigt wird. Soll eine dieser
Darstellungsanweisungen geéandert werden, die
Parameter (wenn bekannt) in den Klammern
andern oder die Darstellungsanweisung ein-
schlieBlich der spitzen Klammern I6schen und tber
das Menu eine andere einfligen.

Wie bei anderen Programmen (z. B. Textverar-
beitung) ist es Uber das Meni oder das entspre-
chende Symbol in der Werkzeugleiste mdglich,
markierte Textpassagen zu kopieren (Edit # Copy/
Bm), auszuschneiden (Edit » Cut/ %) oder zu
I6schen (Edit # Delete). Kopierte oder ausgeschnit-
tene Textpassagen kdénnen entsprechend einge-
flgt werden (File » Paste/@,).

Zur Ubertragung der eingegebenen Nachricht zu
einer an demselben Computer angeschlossenen
Anzeige:

1) Den Menipunkt ,Functions » Send Message...”
aufrufen oder auf die entsprechende Schaltfla-

che # klicken. Das Fenster ,Send Message*“
wird angezeigt (1= Abb. 3).

Send Message E]

Sign ID o] -
Page: & -

@ Fenster ,Send Message”

2) Die Gerateadresse (Sign ID) wahlen (,00“
adressiert alle Gerate), den Speicherplatz
(Page) fur den Text wahlen und mit ,OK" besta-
tigen. Die Nachricht wird in der Anzeige gespei-
chert. Das Fenster ,Send Message® wird nach
der Ubertragung automatisch ausgeblendet.

Zu Ubertragung (lber ein Computernetzwerk
1= Kap. 4.2.9.

4.2.3 Textformatierung

Eine Textformatierung kann am Anfang des Textes
fir den gesamten Text einer Nachricht vorgenom-
men werden. Sie l&sst sich aber auch innerhalb
des Textes wechseln. Dazu die jeweilige Formatie-
rungsanweisung an der gewlnschten Textstelle
einfugen.

Eine Anderung des Schriftstils iber das Meni
JFont* einfligen (normal: 5x7, schmal: 4 x7 oder
fett: 6 x 7), eine Anderung der Textfarbe (iber das
Men( ,,Color“.

4.2.4 Sonderzeichen

Sonderzeichen, die nicht direkt Gber die Tastatur
eingegeben werden koénnen, lassen sich lber das
Meni einfligen:

1) Den Menupunkt ,European » European Char*
aufrufen. Das Fenster ,European Char Form*
mit einer Zeichentabelle (1= Abb. 4) wird ange-
zeigt.

2) Auf das gewlnschte Sonderzeichen klicken.
Der Code dieses Zeichens wird auf der rechten
Seite angezeigt.

3) Den Sonderzeichencode durch Klicken auf
snsert“in den Text einflgen.

4) Bei Bedarf weitere Zeichen auswahlen und ein-
flgen.

5) Das Fenster mit ,Cancel“ wieder ausblenden.
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@ Tabelle der Sonderzeichen

4.2.4.1 Eigene Sonderzeichen

Sind gewlinschte Sonderzeichen nicht in der Zei-
chentabelle enthalten, kénnen bis zu 64 Zeichen
selbst erstellt werden.



1) Den Menupunkt ,European # User Font Make...“
aufrufen. Das Fenster ,Font Make“ wird ange-
zeigt (1= Abb. 5).

[E=E

& Font Make

File  Transfer

Char Code: u4n hd
idth: 4 Height: 7

Font Size: | 447 | Pirels

o Add X Delete

Draw Font

Yas |

Position: {3, 1)

@ Fenster ,Font Make*“

2) Inder Liste ,Char Code“ den Zeichencode fiir das
neue Zeichen wahlen. Das in der Zeichentabelle
(1= Abb. 4) angezeigte Zeichen mit diesem Code
wird dann durch das neue Zeichen ersetzt.

3) In der Liste ,Font Size" den Schriftstil wahlen, fir
den das Zeichen erstellt werden soll.

4) Mit der Schaltflache ,4 Add“ einen Eintrag in der
Liste hinzufugen.

5) Diesen Eintrag in der Liste anklicken. Auf der
rechten Seite wird jetzt ein Gitter in der GroBe
des gewahlten Schriftstils angezeigt.

6) Durch Klicken auf die Felder des Gitters Punkte
fir das Zeichen hinzufligen oder entfernen.

7) Zum Lo6schen aller Punkte auf ,NO* klicken.
Zum Ubernehmen des fertigen Zeichens auf
»Yes“. Das Zeichen wird jetzt klein neben dem
Eintrag in der Liste angezeigt.

8) Um das Zeichen fir einen weiteren Schriftstil zu
erstellen, die Schritte ab 3) wiederholen, zum
Erstellen anderer Zeichen ab Schritt 2).

9) Zum Ld&schen eines Listeneintrags diesen an-
wahlen, auf die Schaltflache ,X Delete” Gber der
Liste klicken und die Sicherheitsabfrage besta-
tigen.

10) Fur die Ubertragung aller erstellten Sonderzei-
chen zur Anzeige den MenUpunkt ,Transfer
» Transfer to Sign...“ aufrufen. Das Fenster
sTransfer Font To Sign“ wird angezeigt.

11) Aus der Liste ,Sign ID“ die Adresse der Anzeige
wahlen (oder ,00“ fur alle Anzeigen) und die
Ubertragung mit , Transfer starten oder den Vor-
gang mit ,Cancel“ abbrechen.

12) Alle selbst erstellten Sonderzeichen kénnen tber
den Menupunkt ,File » Save Font...“ auf dem
Computer gespeichert und Uber ,File » Open
Font..." wieder geladen werden.

13) Das Fenster ,Font Make" tUber den Menupunkt
,File ¥ Quit“ wieder schlieBen.

4.2.4.2 Sonderzeichen zuriicksetzen

Alle selbst erstellten Sonderzeichen kénnen auch
wieder durch die vorgegebenen Sonderzeichen
ersetzt werden.

1) Den MenUpunkt ,European » Recall Default
Font* aufrufen. Das Fenster ,Confirm*“ wird ange-
zeigt.

2) Aus der Liste ,Sign ID“ die Adresse der Anzeige
wahlen (oder ,00“ fur alle Anzeigen) und die
Ubertragung mit ,Yes" starten oder den Vorgang
mit ,No“ abbrechen.

Die Sonderzeichen im Speicher der Anzeige sowie
in der Tabelle ,European Char Form“ entsprechen
jetzt wieder den Vorgaben (15> Abb. 4).

4.2.5 Datum oder Uhrzeit anzeigen,
Signalton abspielen

Um die aktuelle Uhrzeit in einen Text einzufligen
den Menlpunkt ,Commands #» Special Function
» Time* aufrufen, zum Einfligen des Datums den
Menupunkt ,Commands # Special Function » Date*.

Soll zu einer Nachricht ein Signalton abgespielt
werden, den MenUpunkt ,Commands » Special
Function » Bell » aufrufen und dabei mit der letzten
Meniiverzweigung die Lénge des Tons waéhlen:
0,5 bis 2 Sekunden.

4.2.6 Bilder

Zusatzlich zum Text lassen sich auch einfache Bil-
der auf der Anzeige darstellen. Diese kdnnen mit
dem Programm selbst erstellt oder importiert wer-
den. Es koénnen bis zu 26 Bilder in eine Anzeige
geladen werden.

1) Den Menupunkt ,Bmp Graphics » Edit Gra-
phic...“ aufrufen. Das Fenster ,Graphic Form“
wird angezeigt (1=° Abb. 6).
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& GraphicForm [E=1ES|

elect Graph |~ Graphic Size ToolBow

G

Go2 Height |7 dots | widh 96 dots

o ! Fos N
G04

G05

GOE O | &
GO7

E:N S 25888 00088888 #5986 |
GOg L J tP
G10

Gl

G12 73

G13 a 2
G14

G15

G16

3 Bmp.. | Cear |
FE_W Zoom

G20 B hd
G21

G2

G23 {4 ﬂ @ Q
G24

e Seleet Color
== = 9000

@ Fenster ,Graphic Form*“

2) Die Hohe (Height) und Breite (Width) fir das
Bild wahlen. Die BildgréBe maximal so groB3
wahlen, wie die Anzeige darstellen kann. Bilder,
die breiter sind als die Anzeige, kénnen nur mit
dem Einblendeffekt ,Scroll Left“ vollstandig
gesehen werden (1=° Kap. 4.2.7).

3) Unter ,Zoom* kann die Ansicht vergréBert oder
verkleinert werden (1 x... 8 x).

“«

4) Durch Klicken auf die Kreise unter ,Select Color
die gewinschte Zeichenfarbe wéahlen. Die aktu-
elle Farbe wird im Rechteck darUber angezeigt.

5) Unter ,Tool Box“ sind folgende Funktionen zum
Zeichnen des Bildes verflugbar:

J Punkt oder Freihandlinie, diinn
& Freihandlinie, dick
N\ Gerade

U Rechteck

n gefllltes Rechteck
2 Ellipse

® efiillte Ellipse

4 Auswahlrahmen, rechteckig
Auswahl mit linker Maustaste verschieben,
mit rechter Maustaste einfligen

3 Auswahlrahmen, freiférmig
Auswahl mit linker Maustaste verschieben,
mit rechter Maustaste einfligen

Léschen von Bildpunkten

Text einflgen:

1.in den Zeichenbereich klicken

2. Text eingeben

3. Schriftart wahlen ,Font Selection [...]*
4. Hohe ,Height* festlegen

5. mit ,OK* bestéatigen

6. mit linker Maustaste positionieren

7. mit rechter Maustaste einfligen

X gesamtes Bild mit Farbe flllen

N

Durch Klicken auf ,Clear” werden alle gezeich-
neten Punkte geldscht.

«

Durch Klicken auf ,Bmp...“ wird das Fenster
.Bmp Save Load“ angezeigt. Hier ist es mdg-
lich, mit ,Export Bmp...“ ein erstelltes Bild im
Bitmap-Format auf dem Computer zu speichern
oder mit ,Import Bmp...“ ein Bild im Bitmap-For-
mat zu importieren.

>}

Um ein Bild fiir die Verwendung mit der Anzeige
zu sichern, auf ,Save“ klicken. Im Fenster ,Select
Graphi Name“ die Speicherplatznummer (GO0
bis G26) fir das Bild wahlen und mit ,OK" besta-
tigen. Ist bereits ein Bild unter der Nummer
gespeichert, wird eine entsprechende Warnung
angezeigt. Das Uberschreiben mit ,Yes* bestéti-
gen oder mit ,No“ abbrechen.

7) Zum Bearbeiten eines gespeicherten Bildes
dessen Nummer in der Liste ,Select Graph“
anwahlen.

8) Zum L&schen eines gespeicherten Bildes dessen
Nummer in der Liste ,Select Graph“ anwéhlen
und auf ,,Delete” klicken. Im Fenster der anschlie-
Benden Sicherheitsabfrage das L&schen mit
»Yes* bestatigen oder mit ,No“ abbrechen.

9) Zum Einfigen eines gespeicherten Bildes in
eine Nachricht dessen Nummer in der Liste
~Select Graph“ anwahlen und auf ,Insert” kli-
cken. Eine Bildreferenz wird in das Textfenster
(r=> Abb. 2) eingefligt und das Fenster ,Graphic
Form*“ geschlossen.

4.2.7 Ein- und Ausblendeffekte,
Anzeigeoptionen

Um die Anzeige ansprechend und abwechslungs-
reich zu gestalten, stehen zahlreiche Mdglichkeiten
zur Auswahl, auf welche Art der Text auf der
Anzeige erscheint, wie lange er verweilt und auf
welche Art er wieder verschwindet (Beschreibung
der Ein- und Ausblendeffekte 1= Kap. 4.1.4).

1) Zum Festlegen des Einblendeffekts den Men(-
punkt ,Commands # Leading Effect # aufrufen,
dabei mit der letzten Menuverzweigung die Art
des Effektes wahlen und am Anfang der Nach-
richt einfigen.

Hinweis: Ist ein Text breiter als die Anzeige, kann er
mit dem Einblendeffekt ,Scroll Left” vollstdndig gezeigt
werden.

Wird kein Einblendeffekt festgelegt, gilt die Vor-
einstellung ,Scroll Left.

D

Zum Festlegen der Bewegungsgeschwindigkeit
fur den Ein- und Ausblendeffekt den Menlpunkt
,Commands » Move Speed...“ aufrufen. Im
Fenster ,Move Speed” die Geschwindigkeit von



langsam (0 = slow) bis schnell (3 = fast) einstel-
len und mit ,OK“ bestatigen.

Wird keine Bewegungsgeschwindigkeit festge-
legt, gilt die Voreinstellung ,fast”.

3) Uber den Meniipunkt ,Commands #» Display
Effect » mit der letzten Menuverzweigung fest-
legen, ob die Nachricht blinkend (,Blinking“)
angezeigt werden soll oder nicht (,Normal“
= Voreinstellung).

K

Zum Festlegen der Anzeigedauer einer Nach-
richt den MenUpunkt ,Commands # Display
Time...“ aufrufen. Im Fenster ,Move Speed” die
Anzeigedauer (0 bis 25 Sekunden) einstellen
und mit ,OK" bestatigen.

Wird keine Anzeigedauer festgelegt, gilt die Vor-
einstellung 1 s.

o

Zum Festlegen des Ausblendeffektes den Menu-
punkt ,Commands » Closing Effect # aufrufen,
dabei mit der letzten Menliverzweigung die Art
des Effektes wéhlen und am Ende der Nachricht
einfugen.

Wird kein Ausblendeffekt festgelegt, gilt die Vor-
einstellung ,Scroll Left".

4.2.8 Nachricht speichern, laden oder
neu erstellen

Wie bei anderen Programmen (z. B. Textverarbei-
tung) ist es Uber das Menl oder das entspre-
chende Symbol in der Werkzeugleiste mdglich,
erstellte Nachrichten auf dem Computer zu spei-
chern (File » Save.../ [d), gespeicherte Nachrich-
ten zu laden (File » Open.../ &) oder eine neue
Nachricht zu erstellen (File » New/ [[7).

Als Dateiendung wird beim Speichern von
Nachrichten automatisch ,.nsn“ angehangt.

4.2.9 Nachricht iiber ein Netzwerk senden

Ist die Anzeige an einem Computer angeschlos-
sen, der Teil eines Netzwerkes ist, kann von einem
anderen Computer im Netzwerk ein Text auf die
Anzeige gesendet werden. Zu diesem Zweck die
Anzeige an dem mit ihr verbundenen Computer als
lokalen Drucker einrichten:

— Als Druckertreiber den Standardtreiber ,Gene-
ric/Text Only“ verwenden.

— Als Schnittstelle fir den Drucker den COM-Port
wahlen, der fir das Programm simuliert wird
(r=> Kap. 4.2.1).

— Inden Druckereigenschaften die Option ,Druck-
auftrage direkt zum Drucker leiten® wahlen, d. h.
nicht Gber den Drucker-Spooler des Betriebs-
systems drucken lassen.

— Den Drucker flr das Netzwerk freigeben, damit
von anderen Computern des Netzwerkes auf
ihn zugegriffen werden kann.

Von jedem Computer des Netzwerkes, auf dem
das Programm installiert ist, kann jetzt ein Text zu
der Anzeige gesendet werden:

1

2) Den gewinschten Text in das Textfeld eingeben
(r=> Kap. 4.2.2) oder aus einer Datei laden
(1= Kap. 4.2.8).

Uber dem Textfeld auf das Symbol %, ,Send via
Network*® klicken.

-

Das Programm starten.

&L

=

Die Gerateadresse ,Sign ID“ wéhlen (,00“ adres-
siert alle Geréate), den Speicherplatz ,Page” fur
den Text wahlen und mit ,OK" bestatigen.

o

Im Fenster ,Drucken” den Namen des angeleg-
ten Druckers auswéhlen und die Ausgabe be-
statigen.

Lauft in der Anzeige gerade die Nachricht des
gewahlten Speicherplatzes, wird der Text sofort
aktualisiert.

4.2.10 Nachrichten anzeigen

Um eine oder mehrere in der Anzeige gespeicherte
Nachrichten abzurufen:

1) Den Menlpunkt ,Functions » Link Pages To
Run..." aufrufen. Das Fenster ,Link Pages” wird
angezeigt (1> Abb. 7).

Link Pages @

Sign 1D ul1] -

Page: [e.g. abcED]

|abacadeeafz

oK

@ Fenster ,Link Pages*”

2) Inder Liste ,Sign ID* die Gerateadresse wahlen
(,00“ adressiert alle Gerate).

3) Indas Feld unter ,Page” die Speicherplatze der
Nachrichten in der fiir die Anzeige gewlinschten
Reihenfolge eingeben (a ... z oder A ... Z).

4) Die Eingaben mit ,OK* bestatigen. Die Anwei-
sungen werden an die Anzeige Ubertragen und
ausgefihrt.

Nach erfolgter Ubertragung erscheint eine Bestiti-
gungsmeldung.

Die Anzeige einer einzelnen Nachricht ist auch
Uber den MenUpunkt ,Functions » Run Page...”
maoglich.
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4.2.11 Nachrichten zeitgesteuert anzeigen

In der Anzeige gespeicherte Nachrichten kénnen

automatisch zu festgelegten Zeiten tber funf unab-

héngige Programme angezeigt werden.

1) Den Menupunkt ,Functions » Display by Sche-
dule...“ aufrufen. Das Fenster ,Schedule” wird
angezeigt (1= Abb. 8).

Schedule E”El@

MNO. | Start DateTime | End DateTime | Page

1 0819131720 08/221310:20 ACE

2 082311371720 08/24/1310:20 ACE

3 08/25/1317.20 08/26/1310:20  DEF

4 08/271317:20 08/28/1310:20 G

5 08/23/1317.20 08/30M131020 X2

< | ?

R Maify.. | Delete |

Sian ID: |00 - Send

Fenster ,Schedule“

2) Um ein neues Anzeige-Programm hinzuzufu-
gen, auf ,Add...” klicken. Das Fenster ,Sche-
dule-Add“ wird angezeigt (1=° Abb. 9).

Wird versucht, mehr als 5 Programme anzu-
legen, erscheint eine Fehlermeldung.

Schedule-Add 3]
Start DateTime

MM /DDA

Date:  |08/20413
Time : |11:55

End DateTime
(M /DDA

Date: |08/20413
Time: | 12:55
Page |adegH

[e.g: abcDE )
0K |

Cancel ‘

@ Fenster ,,Schedule-Add“

L

Unter ,Start Date Time" das Datum und die Uhr-
zeit flr den Beginn des gewiinschten Anzeige-
zeitraums eingeben. Beim Datum das beson-
dere Eingabeformat (Monat/Tag/Jahr — jeweils
zweistellig) beachten.

Unter ,End Date Time" das Datum und die Uhr-
zeit fur das Ende des gewlinschten Anzeige-
zeitraums eingeben.

o

o

In das Feld ,Page“ die Speicherplatze der
Nachrichten in der fir die Anzeige gewuinschten
Reihenfolge eingeben (a ... z oder A ... Z).

6) Die Eingaben mit ,OK“ bestatigen. Das An-
zeige-Programm erscheint jetzt in der Tabelle
(r= Abb. 8).

Hinweis: In der Tabelle werden nicht die Programme
aus dem Speicher der Anzeige angezeigt, sondern nur
die seit dem Starten der PC-Software erstellten.

7) Wenn gewlnscht, weitere Anzeige-Programme
hinzufligen (1=° Schritt 2).

8) Zur Anderung eines Anzeige-Programms die-
ses in der Tabelle auswéahlen und auf ,Modify...“
klicken. Im Fenster ,Schedule Modify“ die Daten
andern und mit ,OK" bestatigen oder mit ,Can-
cel“ die Anderungen verwerfen. Zum Léschen
eines Anzeige-Programms aus der Tabelle die-
ses auswahlen und auf ,Delete” klicken.

9) Inder Liste ,Sign ID* die Gerateadresse wahlen
(,00" adressiert alle Gerate).

10) Mit dem Klicken auf ,Send“ die Daten an die
Anzeige ubertragen. Vorhandene Programme
im Speicher der Anzeige werden dabei ersetzt.
Nach erfolgter Ubertragung erscheint eine Be-
statigungsmeldung.

4.2.12 Systemeinstellungen

4.212.1 Datum und Uhrzeit einstellen
1) Den MenUpunkt ,Functions » Set Clock...“ auf-
rufen. Das Fenster ,Set Clock” wird angezeigt.

2) Inder Liste ,Sign ID* die Gerateadresse wahlen
(,00“ adressiert alle Geréte).

3) Neben ,Date“ das Datum wéhlen und neben
»1ime“ die Uhrzeit eingeben.

4) Die Eingabe mit ,OK* bestatigen oder mit ,Can-
cel“ abbrechen.

Nach erfolgter Ubertragung der Daten erscheint
eine Bestatigungsmeldung.

4.212.2 Helligkeit &ndern

1) Den Menupunkt ,Functions # Set Brightness...“
aufrufen. Das Fenster ,Set Brightness” wird
angezeigt.

2) Inder Liste ,Sign ID" die Gerateadresse wahlen
(,00“ adressiert alle Geréte).

3) Inder Liste ,Brightness” die gewiinschte Hellig-
keit wahlen (100 %, 75 %, 50 %, 25 %).

4) Die Eingabe mit ,OK" bestatigen oder mit ,Can-
cel* abbrechen.

Nach erfolgter Ubertragung der Daten erscheint
eine Bestatigungsmeldung.

4.212.3 Geréte-Adresse (ID) &ndern
1) Den MenUpunkt ,Functions # Set ID...“ aufrufen.
Das Fenster ,Set Sign ID“ wird angezeigt.



2) In der Liste ,Sign ID“ die zukinftige Gerate-
adresse wahlen und mit ,OK“ bestatigen.

3) Die Anderung im Bestéatigungsfenster mit ,Yes®
bestatigen oder mit ,No“ abbrechen.

Nach erfolgter Ubertragung der Daten erscheint
eine Bestatigungsmeldung.

4.2.12.4 Nachrichten in der Anzeige l6schen

1) Den Menlpunkt ,Functions » Delete Page...”
aufrufen. Das Fenster ,Delete Page“ wird ange-
zeigt.

2) Inder Liste ,Sign ID“ die Gerateadresse wahlen
(,00“ adressiert alle Geréte).

3) In den Kastchen vor den Speicherplatzen
(Page A bis Page Z) einen Haken setzen, deren
Nachrichten in der Anzeige geléscht werden
sollen.

4) Die Eingabe mit ,OK" bestatigen oder mit ,,Can-
cel“ abbrechen.

Nach erfolgter Ubertragung der Daten erscheint
eine Bestatigungsmeldung.

4.212.5 Anzeige-Programme in der Anzeige I6schen

1) Den Menlpunkt ,Functions #» Delete Sche-
dule...” aufrufen. Das Fenster ,Delete Sche-
dule” wird angezeigt.

2) Inder Liste ,Sign ID“ die Gerateadresse wahlen
(,00“ adressiert alle Geréte).

3) In den Kastchen vor der Nummer der Anzeige-
Programme einen Haken setzen, die in der
Anzeige geldscht werden sollen.

4) Die Eingabe mit ,,OK" bestatigen oder mit ,,Can-
cel“ abbrechen.

Nach erfolgter Ubertragung der Daten erscheint
eine Bestatigungsmeldung.

4.2.12.6 Alle Nachrichten und Programme ldschen

Alle vom Benutzer gespeicherten Nachrichten und

Anzeige-Programme kdénnen mit der folgenden

Funktion geléscht werden.

1) Den Menupunkt ,Functions » Delete All...“ auf-
rufen. Das Fenster ,Delete All“ wird angezeigt.

2) Inder Liste ,Sign ID* die Gerateadresse wahlen
(,00“ adressiert alle Gerate).

3) Die Eingabe mit ,,OK" bestatigen oder mit ,,Can-
cel“ abbrechen.

Nach erfolgter Ubertragung der Daten erscheint

eine Bestatigungsmeldung.

Diese Bedienungsanleitung ist urheberrechtlich fir MONACOR® INTERNATIONAL GmbH & Co. KG geschilitzt.

5 Technische Daten

Anzahl der LEDs: ....... 560 RGB-LEDs
Stromversorgung: .. ..... Uber beiliegendes
Netzgeréat
an 230 V~/50 Hz
Abmessungen: ......... 502 x 67 x 18 mm
Gewicht: .............. 900g

Anderungen vorbehalten.

Eine Reproduktion fiir eigene kommerzielle Zwecke — auch auszugsweise — ist untersagt.

D
LA
CH

15



@ Contents

16

1 Applications . ...................... 17
2 SafetyNotes ...................... 17
3  Setting the Display into Operation ....17
3.1 Mounting ............. ... ... ... 17

3.2 Inserting batteries into the remote control . 17

3.3 Connecting the computer ............. 17
3.4 Mainsconnection ................... 18
3.5 |Installing the PC software ............. 18
3.5.1 Installing the USB driver ............ 18
4 Operation ......................... 18
4.1 Operation via IR remote control ........ 18
4.1.1 Switchingon/off ................... 18
4.1.2 Displaying date andtime ............ 18
4.1.3 Quicktextentry ................... 18
4131 Textentry ...................... 18
4.1.4 Saving texts with effects ............ 19
4.1.5 Displayingmessages .............. 19
4.1.6 Time-controlled display ............. 20
417 Systemsettings ................... 20
4171 Settingdate andtime............. 20
4.1.7.2 Changing the brightness .......... 20
4.1.7.3 Changing the unit address (ID) .. ... 20
4.1.7.4 Deleting all messages and programs 20
4.1.7.5 Activating or deactivating beep of the
button.......... ... ... .. L. 21

4.2 Operation via acomputer ............. 21
421 Setting theinterface ............... 21
4.2.2 Entering a message and

transferring it to the display . ......... 21
423 Textformatting.................... 22
4.2.4 Specialcharacters ................. 22
4.2.41 User-defined special characters ... .22
4.2.4.2 Resetting special characters ....... 23
4.2.5 Displaying date or time,

reproducing an acoustic signal ....... 23

@ Lateral view

426 Graphics ..., 23
4.2.7 Fade-in and fade-out effects,
displayoptions . . .................. 24
4.2.8 Saving, loading or creating a message . 24
4.2.9 Sending a message via a network . ...24
4.2.10 Displaying messages .............. 25
4.2.11 Time-controlled message display .. ... 25
4.212 Systemsettings . .................. 26
4.2.12.1 Settingdate andtime............. 26
4.2.12.2 Changing the brightness .......... 26
4.2.12.3 Changing the unit address (ID) .. ... 26

4.2.12.4 Deleting messages from the display . 26

4.2.12.5 Deleting display programs from
thedisplay ..................... 26

4.2.12.6 Deleting all messages and programs 27

5 Specifications ..................... 27



1 Applications

The LED display can visualize text and plain graph-
ics on a matrix of 7 x 80 LEDs. The RGB LEDs
allow for visualizations in the primary colours red,
green and blue and in the mixed colours yellow,
cyan, magenta and white. The displays can be
operated via the infrared remote control supplied or
via USB using a computer. Up to 26 messages can
be saved on the display. The messages may be
arranged in any order desired and may be en-
dowed with various effects to arouse attention. The
integrated clock allows for a time-controlled display
or for the display of date and time. An internal buffer
battery keeps the data entered and ensures that
the clock continues working after the power supply
has been disconnected. The PC program allows
users to create their own graphics and special
characters.

2 Safety Notes

These units (display and power supply unit) corre-
spond to all relevant directives of the EU and are
therefore marked with C€.

WARNING The power supply unit uses dange-

rous mains voltage. Leave servicing
to skilled personnel only. Inexpert
handling may result in electric shock.
Please observe the following items in any case:
® The units are suitable for indoor use only. Protect
them against dripping water and splash water,
high air humidity and heat (admissible ambient
temperature range 0—-40 °C).

® Do not operate the display and immediately dis-

connect the mains plug from the socket

1. if the units or the mains cable are visibly dam-
aged,

2. if a defect might have occurred after a unit was
dropped or suffered a similar accident,

3. if malfunctions occur.

In any case the units must be repaired by skilled

personnel.

® Never pull the mains cable to disconnect the
mains plug from the socket, always seize the
plug.

® For cleaning only use a dry, soft cloth; never use
water or chemicals.

® No guarantee claims for the units and no liability
for any resulting personal damage or material

damage will be accepted if the units are used for
other purposes than originally intended, if they
are not correctly connected or operated, or if
they are not repaired in an expert way. Likewise,
no liability will be accepted for data loss caused
by operating errors or by a defect or for any con-
sequential damage of this data loss.

hid

If the unit is to be put out of operation defi-
nitively, take it to a local recycling plant for
a disposal which is not harmful to the envi-
ronment.

3 Setting the Display
into Operation

3.1 Mounting

To mount the display to a wall, for example, use the
mounting brackets (2) supplied. Fasten the mount-
ing brackets to the display (see figure 1), using two
of the supplied screws for each bracket.

WARNING Install

A

the display safely and
expertly. When installing the display
at a place where people may walk or
sit under it, equip its mounting with
an additional security mechanism to
prevent it from dropping or make
sure that the mounting cannot get
disengaged.

3.2 Inserting batteries into

the remote control
The battery compartment is located on the bottom
side of the remote control.

1) Remove the cover of the battery compartment.

2) Insert two batteries (AAA size). Observe the
polarity (indicated in the battery compartment).

3) Replace the cover to close the battery compart-
ment.

3.3 Connecting the computer

For remote-controlled operation or setup of the dis-
play via a computer, connect the computer by
means of the adapter cable supplied. Connect the
plug to the jack (3) of the display, and connect the
USB plug to a USB port of the computer.

Note: To make sure that no transmission errors occur, only
use USB extension cables with signal amplification.

17



@ 3.4 Mains connection
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Connect the low-voltage plug of the power supply
unit (provided with the display) to the low-voltage
jack (1) and connect the power supply unit to a
mains socket (230V~/50Hz), using the mains
cable. This will switch on the display. The system
information will be briefly shown one after the other
and then the message most recently selected will
appear.

3.5 Installing the PC software

The installation of the control program supplied
requires a PC equipped with the Windows 98,
Windows ME, Windows NT, Windows 2000,
Windows XP operating system or later, a memory
of at least 32 MB and a USB interface. To install the
PC software, insert the CD supplied, and then click
“Install Software” on the “Welcome” screen that
automatically appears. If the “Welcome” screen
fails to appear, start the installation program
SETUP.EXE on the CD supplied and follow the
instructions of the installation program.

Windows is a registered trademark of Microsoft Corporation in the United States
and other countries.

3.5.1 Installing the USB driver

The connection via the USB interface requires a
special driver which simulates a serial interface for
the control program. If no appropriate driver is
installed on the computer, install the driver from the
CD supplied.

4 Operation

The display may be operated either via the infrared
remote control supplied or via a computer on which
the control program supplied is installed. The con-
trol program provides some additional functions,
e.g. for creating user-defined graphics or special
characters.

4.1 Operation via IR remote control

To operate the display via the infrared remote con-
trol supplied, align the infrared remote control with
the infrared sensor located to the right of the LED
field. The display acknowledges each command it
receives from the remote control with a beep, pro-
vided the beep has not been deactivated (15> chap-
ter 4.1.7.5).

4.1.1 Switching on/off

The display is always switched on once it has been
connected to the power supply. To switch the dis-

play on or off via the remote control, press the but-
ton [ON/OFF].

4.1.2 Displaying date and time

To alternately display the current date and time
instead of the message, press the button [TIME/
DATE]. To return to the message display, press the
button [ESC].

Date and time adjustment =" chapter 4.1.7.1.

4.1.3 Quick text entry
To quickly and comfortably enter a one-line text:

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [Q-PROG]. “QUICK PAGE
EDIT” is briefly displayed.

3) Enter the text (1=° chapter 4.1.3.1).

4) Press [ENTER] to complete the text entry. The
text entry automatically appears on the display.

4.1.3.1 Textentry

The text (max. 210 characters) is entered by
means of the character buttons [A] to [Z]. Use the
button [SHIFT] to switch between uppercase char-
acters (cursor appears as: “1”), lowercase charac-
ters (“1”), numerals/special characters (white but-
ton labelling, “”) and other special characters
(green button labelling, “I”).

For some characters, variants are available. To
select the variants of a specific character, press the
appropriate character and then (repeatedly) press
the button [EUROP-CHAR]:

Character Variants Character Variants
A AAAARRAE a ddaasae
B B
Cc C c c
D b
E EEEE e ceée
I i i Qi
N N n fi
o) 0006060 o 066686
P P p o]

U uuou u uaaa
Y vy y vy

Note: With the PC software, users can overwrite the vari-
ants with their user-defined characters and then retrieve
them via the remote control.

To enter a space character, press [SPACE]; to
delete the last character, press [DEL].

To change the font style (standard: 5x7, con-
densed: 4 x 7 or bold: 6 x 7 = pixels per character:
horizontal x vertical), press [FONT]; to change the
text colour, press [COLOR].



4.1.4 Saving texts with effects

26 texts, each with defined fade-in and fade-out
effect, display time and fade-in/fade-out speed,
can be saved as messages on the display. The
texts can be displayed individually or combined in
any order.

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [PROG]. “PROGRAM” is
briefly displayed, and then “EDIT PAGE?”
appears on the display.

Press [ENTER]. “EDIT PAGE: A” is displayed.

Press [1] or [{] to select the storage location (A
to Z) and then press [ENTER] to confirm.
“B]I_EFF”, for example, is displayed, if storage
space B has been selected.

£

Note: A quick text entry (E= chapter 4.1.3) will over-
write storage location A.

o

Press [T] or [{] to select the fade-in effect
(I_EFF).

The following fade-in effects are available:

Immediate immediate text display without any
fade-in effect

Open fade-in from the centre to the cor-
ners

Curtain Up fade-in from the bottom to the top

Curtain Down fade-in from the top to the bottom

Scroll Left scroll-in from right to left

Scroll Right scroll-in from left to right

Vopen fade-in from the centre to the top
and to the bottom

Vclose fade-in from the top and the bottom
to the centre

Scroll Up scroll-in from the bottom to the top

Scroll Down scroll-in from the top to the bottom

Curtain Left fade-in from right to left

Curtain Right fade-in from left to right

Snow dots dropping from the top (like
snow)

Twinkle twinkle effect with changing waves
or colours

Block Move scroll-in of blocks from the right

Random random appearance of the individ-

ual pixels

Note: If the text is longer than the display, use the fade-
in effect “Scroll Left” to show the entire text.

6) Press [—] to adjust the display duration. Now
“BISTAY : 02 Sec”, for example, is displayed.
Press [1] or [{] to select the display duration (0
to 25s) for the text.

To return to the previous entry, press [«]; to
cancel the setting at any time, press the button
[ESC].

7) Press [=] to adjust the display speed. Now
“BJSPEED:2”, for example, is displayed. Press
[1] or [{] to select the display speed (1 to 4) for
the effects.

8) Press [—] to adjust the display mode. Now
“BJMODE :Normal”, for example, is displayed.
Press [1T] or [{] to define if the text shall be blink-
ing (Blink) or not (Normal).

9) Press [—] to adjust the fade-out type. Now
“B]O_EFF:Immediate”, for example, is dis-
played. Press [1] or [{] to select the fade-out
effect.

The following fade-out effects are available:

Immediate the text disappears without any
effect

Open/Close fade-out from the centre to the cor-
ners

Curtain Up fade-out from the bottom to the top

Curtain Down fade-out from the top to the bottom

Scroll Left scroll-out to the left

Scroll Right scroll-out to the right

Vopen fade-out from the centre to the top
and to the bottom

Vclose fade-out from the top and the bot-
tom to the centre

Scroll Up scroll-out to the top

Scroll Down scroll-out to the bottom

Curtain Left fade-out from right to left

Curtain Right fade-out from left to right

Hold the text stays on the display

10) Press the button [ENTER]. “Page B Content”,
for example, is briefly displayed. Then the text
desired can be entered (1= chapter 4.1.3.1).

11) Press the button [ENTER]. The message is
saved and can be displayed (1=5° chapter 4.1.5).

4.1.5 Displaying messages
To display one or multiple messages that have
been saved:

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [RUN-PAGE]. “EDIT RUN
PAGE?” is briefly displayed.

3) Use the buttons [A] to [Z] to enter the storage
locations of the messages in the order in which
they are to appear on the display. Use the but-
ton [DEL] to correct wrong entries.

4) Press [ENTER] to complete the entry.

All messages selected are briefly displayed and
then repeatedly appear on the display according to
the parameters that have been defined. If a storage
location does not contain any message, the error
message “EMPTY PAGE” will be displayed.

19
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Five independent programs allow for the automatic
display of saved messages at specific times. To
create a program:

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [PROG]. “PROGRAM” is
briefly displayed, and then “EDIT PAGE?”
appears on the display.

3) Press[{]togoto “EDIT SCHEDULE?” and then
press [ENTER] to confirm. “EDIT SCHED-
ULE:1” is displayed.

4) Press [1] or [{] to select the storage location (1
to 5) and then press [ENTER] to confirm.
“2]START YEAR:13", for example, is displayed
when storage location 2 has been selected.

5) Press [T] or [{] to set the number of the year for
the start time.

6

=

Press [—] to go to the month for the start time
“START MONTH?” and then set the month, using
[T]or[L].

Use the same procedure to enter the day
“START DAY”, the hour “START HOUR” and the
minute “START MIN.” for the start time.

Then proceed in the same way to enter the
year “STOP YEAR”, the month “STOP MONTH?,
the day “STOP DAY”, the hour “STOP HOUR”
and the minute “STOP MIN.” which define the
point of time until which the display is to be
shown.

To return to the previous entry, press [«]; to
cancel the setting at any time, press the button
[ESC].

Press the button [ENTER]. “Display Pages” is
briefly displayed. Then use the buttons [A] to [Z]
to enter the storage locations of the messages
in the order in which they are to appear on the
display. Use the button [DEL] to correct wrong
entries.

8) Press [ENTER] to complete the entry.

.

4.1.7 System settings

4.1.7.1 Setting date and time

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [FUNCT]. “FUNCTION” is
briefly displayed, and then “CLEAR ALL”
appears on the display.

3) Press [{] repeatedly until “YEAR?”, for example,
is displayed.

4) Press [ENTER].

5) Press [1] or [{] to change the setting, and then
press [ENTER] to confirm.

Repeat the steps 2) to 5) as required. In step 3),

select the “MONTH?”, the “DAY”, the “HOUR” or the

“MINUTE”.

The setting can be cancelled at any time with
[ESC].

4.1.7.2 Changing the brightness

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [FUNCT]. “FUNCTION” is
briefly displayed, and then “CLEAR ALL”
appears on the display.

3) Press [!] repeatedly until “BRIGHTNESS” is
displayed.

4) Press [ENTER].

5) Press [1] or [{] to select the brightness:
4=100%,3=75%,2=50%,1=25%

Press [ENTER] to confirm.

The setting can be cancelled at any time with
[ESC].

4.1.7.3 Changing the unit address (ID)

To distinguish multiple units, each unit may be

assigned an individual ID/address:

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [FUNCT]. “FUNCTION” is
briefly displayed, and then “CLEAR ALL”
appears on the display.

3) Press [{] repeatedly until “SET ID” is displayed.

4) Press [ENTER]. The current address is dis-
played, e.g. “SET ID : 01”.

5) Press [1T] or [{] to set the address (hexadeci-
mal). Press [ENTER] to confirm.

The setting can be cancelled at any time with
[ESC].

4.1.7.4 Deleting all messages and programs

All the messages and display programs the user

may have saved can be deleted by means of the

following function.

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [FUNCT]. “FUNCTION” is
briefly displayed, and then “CLEAR ALL”
appears on the display.

3) Press [ENTER]. “CLEAR ALL:NO” is displayed.



4) Press [1] to go to “CLEAR ALL:YES”.

5) To confirm the deletion, press [ENTER] or, to
cancel the procedure, press [ESC].

The promotional text that is then shown on storage

location A can be overwritten with another message

(1= chapters 4.1.3 and 4.1.4.).

4.1.7.5 Activating or deactivating beep of the button
If desired, the display will beep for each command
it receives from the remote control.

1) If the date/time display is active, press the but-
ton [ESC] to deactivate it.

2) Press the button [FUNCT]. “FUNCTION” is
briefly displayed, and then “CLEAR ALL”
appears on the display.

3) Press [{] repeatedly until “KEY SOUND” is dis-
played.

4) Press [ENTER]. “KEY SOUND: NO”, for exam-
ple, is displayed.

5) Press [1] or [{] to activate the beep tone (YES)
or to deactivate it (NO).

6) To confirm the setting, press [ENTER]; to cancel
the setting, press [ESC].

4.2 Operation via a computer

Start the control program ,Multi-color Sign|[...].EXE*

on the PC. The main window (1= fig. 2) appears.
[=1E3)

File Edit Commands European Font Color Bmp Graphics Functions Help

DeE +BR % 3
Line 1
<0pen><Font5x7>Text - text - texte -

<Magenta>testo - texto - tekst <U29>
<Scroll Up:-

57

@ Main window with text

4.2.1 Setting the interface

Select the appropriate interface so that the pro-
gram can transfer data to the display.

1) Activate the menu item File » Set COM... and
then, from the list, select the number of the inter-
face that the USB driver simulates for the pro-
gram.

The appropriate settings of the operating sys-
tem can, for example, be found under » Control
Panel » System Properties (Hardware) » Device
Manager » Ports (COM and LPT).

It reads, for example: “USB to UART[...] (COM3)”

If the computer has assigned a COM number
higher than 8 to the interface, the COM number
must be manually changed to a number between
1 and 8 (e.g. via » Properties » Port Settings
» Advanced ...).

The transmission parameters must be set for
the interface as follows (e.g. via » Properties
» Port Settings):

bits per seconds: 9600
data bits: 8

parity: none
stop bits: 1

flow control: Xon/Xoff

2) Click “OK” to confirm.

4.2.2 Entering a message and
transferring it to the display

In the text window, enter the text to be displayed
(1= fig. 2). The bottom of the window indicates the
number of characters that have been entered. If the
user tries to enter more than 210 characters, a
message will appear informing the user that the
maximum number of characters has been reached.

The menu allows the user to include formatting
instructions (1=° chapter 4.2.3), special characters
(1= chapter 4.2.4), date and time (1=° chapter 4.2.5),
graphics (1= chapter 4.2.6) or fade-in, fade-out or
display effects (1= chapter 4.2.7). The formatting
instructions (shown in red and included in angle
brackets) define how the text is to be displayed. To
modify a formatting instruction, either change the
appropriate parameter (if known) in the angle
brackets or delete the formatting instruction along
with its angle brackets and add a new formatting
instruction via the menu.

As with other programs (e. g. word processing),
the menu or the appropriate icon in the toolbar
allows the user to copy marked passages of text
(Edit » Copy/ Bz), cut them (Edit » Cut/ % ) or delete
them (Edit # Delete). Copied or cut passages of text
can be inserted (File » Paste/@&).

To transfer the entered message to a display that is
connected to the same computer:

1) Activate the menu item “Functions » Send Mes-
sage...” or click the appropriate button 4. The
window “Send Message” appears (1= fig. 3).
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Send Message @

Sign ID oo A
Page: r -

(3 Window “Send Message”

2) Select the unit ID (Sign ID) [“00” will select all
units] and the storage location (page) for the
text and then click “OK” to confirm. The mes-
sage is saved on the display. The window “Send
Message” will disappear automatically once the
transmission has been completed.

Transferring messages via a computer network
15 chapter 4.2.9.

4.2.3 Text formatting

The text format can be defined at the beginning of
the text and will then apply to the entire text of the
message. However, it is also possible to change
the text format within the text by including the
appropriate formatting instruction at the text loca-
tion desired.

Use the menu “Font” to change the font style
(standard: 5x7, condensed: 4x7 or bold: 6 x7);
use the menu “Color” to change the text colour.

4.2.4 Special characters

Special characters that cannot be directly entered
via the keyboard may be inserted via the menu:

1

—

Activate the menu item “European » European
Char”. The window “European Char Form” with
a character map appears (1= fig. 4).

»

Click the special character desired. The code is
shown right next to the character.

3) Click “Insert” to insert the code of the special
character into the text.

K

If required, select additional special characters
and insert them into the text.

5) Click “Cancel” to close the window.
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4.2.4.1 User-defined special characters
If the special characters desired are not included in

the character map, users may define up to 64 char-
acters of their own.

1) Activate the menu item “European » User Font
Make...”. The window “Font Make” appears
(r= fig. 5).

B Font ke EBX
File  Transfer

Char Code: U140 -

Widih 4 Height: 7
Fort Size: [447 | Pinels
Draw Fant
op Add X Delete
e [
Pasition: (3, 1)

@ Window “Font Make”

2) From the list “Char Code”, select the character
code for the new character. In the character
map (1= fig. 4), the new character will replace
the character that was previously assigned to
the code selected.

3) From the list “Font Size”, select the font style for
which the character is to be created.

Use the button 4 Add“ to add an entry to the
list.

5) Click this new list entry. A grid with the size of the
font style selected appears on the right-hand
side of the window.

=



6) Click the fields of the grid to add or delete pixels.

7) To delete all pixels, click “NO”. To adopt the
character, click “Yes”. A miniature sample of the
character is now shown next to the list entry.

*

To create the character for another font style,
repeat this procedure from step 3) onwards. To
create another character, repeat this procedure
from step 2) onwards.

L

To delete a list entry, select the appropriate list
entry, click the button ,X Delete” located above
the list and then confirm the confirmation mes-
sage.

10) To transfer all created special characters to the
display, activate the menu item “Transfer
» Transfer to Sign...”. The window “Transfer
Font To Sign” appears.

11) From the list “Sign ID”, select the address of the
display (or “00” to select all displays) and then
either click “Transfer” to start the transfer or click
“Cancel” to cancel the procedure.

12) All user-defined special characters can be
saved on the computer via the menu item “File
» Save Font...” and can be loaded via the menu
item “File » Open Font...”.

13) Use the menu item “File » Quit” to exit the win-
dow “Font Make”.

4.2.4.2 Resetting special characters

All user-defined characters may be replaced by the
predefined special characters:

1) Activate the menu item “European » Recall
Default Font”. The window “Confirm” appears.

2) From the list “Sign ID”, select the address of the
display (or “00” to select all displays) and then
either click “Yes” to start the transfer or click
“No” to cancel the procedure.

The special characters both in the storage of the
display and in the map “European Char Form” are
reset to the predefined settings (1= fig. 4).

4.2.5 Displaying date or time, reproducing an
acoustic signal

To insert the current time into a text, activate the

menu item “Commands # Special Function » Time”.

To insert the current date, activate the menu item

“Commands # Special Function » Date”.

For an acoustic signal to sound while the mes-
sage is being displayed, activate the menu item
“Commands » Special Function » Bell ¥”; in the last
menu branch, select the duration of the acoustic
signal: 0.5 to 2 seconds.

4.2.6 Graphics

In addition to text, plain graphics can be displayed.
Users can import graphics or create their own
graphics with the program. Up to 26 graphics can
be loaded into a display:

1) Activate the menu item “Bmp Graphics » Edit

Graphic...” The window “Graphic Form”
appears (1= fig. 6).
® GraphicForm DEX

elect Graph — Graphic Size ToolBox
GO1

2o Heght [Tt <] widh  [%dos

g ol ol @ =
G2d Select Colot
ggg [irsert s. ‘ Delete ‘ o
rser ave clete
[ 151 19
QCOC

@ Window “Graphic Form”

2) Select the height and the width for the graphic.
The maximum graphic size is equal to the size
that can be shown on the display. If the graphic
is wider than the display, use the fade-in effect
“Scroll Left” to show the entire graphic
(r=> chapter 4.2.7).

3) To change the size of the view, use the field
beneath “Zoom” (1 x...8x).

4) Click one of the circles beneath “Select Color” to
select the colour desired. The colour currently
selected is shown in the square right above the
circles.

o

Under “Toolbox”, the following graphic drawing
functions are available:

J point or freehand line, thin
freehand line, thick
straight line

rectangle, filled

&

AN

U rectangle
|

= ellipse
®

ellipse, filled

- selection frame, rectangular
left mouse button to move the selection
frame; right mouse button to insert the se-
lection frame

GE]
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3 selection frame, freehand
left mouse button to move the selection
frame; right mouse button to insert the se-
lection frame

pixel deletion

add text:

. click in the graphic area

. enter text

. select the font “Font Selection [...]”
. define the height

. click “OK” to confirm

. position with the left mouse button
7. insert with the right mouse button

N

[o)N¢) I VRN \O I

# colour fill of the entire graphic

To delete all pixels you have drawn, click
“Clear”.

Click “Bmp...” to open the window “Bmp Save
Load”. This window provides: the option “Export
Bmp...” which allows users to export a bitmap
file to the computer; the option “Import Bmp...”
which allows users to import a bitmap file.

2

To save a graphic so that it can be used on the
display, click “Save”. In the window “Select
Graphi Name”, select the storage location (GO0
to G26) for the graphic and then click “OK” to
confirm. If a graphic has already been saved
with this number, a warning message will
appear. Click “Yes” to confirm the overwrite or
“No” to cancel.

J

To edit a graphic saved, select the appropriate
graphic number from the list “Select Graph”.

*

To delete a graphic saved, select the appropri-
ate number from the list “Select Graph” and then
click “Delete”. A confirmation message appears;
to confirm the deletion, click “Yes”, or, to cancel
the procedure, click “No”.

L

To insert a graphic saved into a message, select
the appropriate graphic number from the list
“Select Graph” and then click “Insert”. A graphic
reference is inserted in the text window
(r==> fig. 2) and the window “Graphic Form” is
closed.

4.2.7 Fade-in and fade-out effects,

display options
Many options are available to facilitate an attractive
and varied display design, i. e. users can, for exam-
ple, define how the text appears, how long it is
shown and how is disappears (description of the
fade-in and fade-out effects 1= chapter 4.1.4).

1) To define the fade-in effect, activate the menu
item “Commands # Leading Effect »”; in the last
menu branch, select the type of the effect and
then insert it at the beginning of the message.

Note: If the text is longer than the display, use the fade-
in effect “Scroll Left” to show the entire text.

If no fade-in effect is defined, “Scroll Left” will be
applied by default.

2) To define the speed of the fade-in and fade-out
effect, activate the menu item “Commands
» Move Speed...”. In the window “Move Speed”,
set the speed between slow (0) to fast (3) and
then click “OK” to confirm.

If no speed is defined, “fast” will be applied by
default.

3) Activate the menu item “Commands # Display
Effect »”; in the last menu branch, define if the
message shall be blinking or not (“Normal” =
default).

4) To define the duration of the message display,
activate the menu item “Commands # Display
Time...”. In the window “Move Speed”, set the
display duration (0 to 25 seconds) and then click
“OK” to confirm.

If no display duration is defined, a duration of
1 second will be applied by default.

5) To define the fade-out effect, activate the menu
item, “Commands # Closing Effect »”. In the last
menu branch, select the type of effect and insert
it at the end of the message.

If no fade-out effect is defined, “Scroll Left” will
be applied by default.

4.2.8 Saving, loading or creating a message
As with other programs (e. g. word processing), the
menu or the appropriate icon in the toolbar allows
the user to save created messages on the com-
puter (File » Save.../ [d), load saved messages
(File ® Open.../ &) or create a new message (File
» New/ 7).

The file extension “.nsn” is automatically ap-
pended while the messages are being saved.

4.2.9 Sending a message via a network

If the display is connected to a computer which is
part of a network, another computer on the network
will be able to send a text to the display. For this
purpose, the display must be defined as the local
printer on the computer to which the display is con-
nected:



— Use the standard driver “Generic/Text Only” as
the printer driver.

— Select the COM port that simulates the driver for
the program as the interface (1=° chapter 4.2.1).

— In the “Printer Properties”, select the option
“Print directly to the printer” so that print jobs are
not processed by the printer spooler of the oper-
ating system.

— Share the printer with the network so that it can
be accessed by other computers on the network.

Every computer on the network on which the pro-
gram is installed can now send a text to the display:
1) Start the program.

2) Enter the text desired into the text field

(1= chapter 4.2.2) or load it from a file (1= chap-
ter 4.2.8).

3) Click the icon %, “Send via Network” located
above the text field.

4) Select the unit address “Sign ID” (“00” will select
all units) and the storage location “Page” for the
text and then click “OK” to confirm.

5) In the window “Print”, select the name of the
printer created and then confirm your selection.

The text on the display will be immediately updated

if the display is currently showing the message of

the storage location selected.

4.2.10 Displaying messages

To call up one or more messages saved on the dis-

play:

1) Activate the menu item “Functions # Link Pages
To Run...”. The window “Link Pages” appears
(== fig. 7).

ink Pages E]

SignID: |00 -

Page: [e.q. abcED)

|ahacadaeef2

Ok

(7) Window “Link Pages”

2) Select the unit ID from the list “Sign ID” (“00” will
select all units).

3) In the field beneath “Page”, enter the storage
locations of the messages in the order in which
the messages are to be shown on the display
(a...zorA...2).

4) Click “OK” to confirm. The instructions are trans-
ferred to the display and executed there.

Once the transmission has been completed, a con-
firmation message appears.

It is also possible to display a single message via
the menu item “Functions » Run Page...”.

4.2.11 Time-controlled message display

Five independent programs allow for the automatic
display of saved messages at specific times.

1) Activate the menu item “Functions # Display by
Schedule...”. The window “Schedule” appears
(r= fig. 8).

Schedule
HO | Start DateTime | End DateTime | Page
1 0813131720 08/221310:20 ACE
2 08/231317:20 08/241310:20 ACE
3 08/26M317:20 08/26M1310:20  DEF
4 08/271317:20 08/28131020 G
5 08/231317:20 08/30A1310:20 »Z

Chdd] T todify. | Delete ‘
SignID: |00 - Send

Window “Schedule”

2) To add a new display program, click “Add...”.

The window “Schedule-Add” appears (1= fig. 9).

If the user tries to create more than 5 pro-
grams, an error message will appear.

Schedule-Add 3

Start D ateTime

(MDD Y]

Date:  |08/20/13
Time: |11:55
End DateTime

(MDD Y]

Date; |D8720413
Time: |12:55
Page |adegH

[e.q: abcDE ]
ok |

Cancel |

@ Window “Schedule-Add”

3) Under “Start Date Time”, enter the date and the
time for the start of the display period desired.
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Observe the format (month/day/year — each
with two digits) when entering the date.

Under “End Date Time”, enter the date and the
time for the end of the display period desired.

In the field “Page”, enter the storage locations of
the messages in the order in which the mes-
sages are to be shown on the display (a ... z or
A...2).

Click “OK” to confirm your entries. The display
program is now included in the table (1= fig. 8).
Note: The table does not include the programs of the

display storage; it only includes the programs that have
been created since the PC software was started.

=

o

2

7) If desired, add further display programs
(1= step 2).

8) To change a display program, select the appro-
priate program from the table and click “Mod-
ify...”. In the window “Schedule Modify”, change
the data and then click “OK” to confirm your
changes or click “Cancel” to reject them. To
delete a display program from the table, select
the appropriate program and click “Delete”.

9) Select the unit address from the list “Sign ID”
(“00” will select all units).

10) Click “Send” to transfer the data to the display.
Programs that already exist in the display stor-
age will be overwritten. Once the transmission
has been completed, a confirmation message
will appear.

4.2.12 System settings

4.2.12.1 Setting date and time

1) Activate the menu item “Functions # Set Clock...”".
The window “Set Clock” appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Next to “Date”, enter the date, and next to
“Time”, enter the time.

4) Click “OK” to confirm your entries, or click “Can-
cel” to cancel the procedure.

Once the transmission has been completed, a con-
firmation message will appear.

4.2.12.2 Changing the brightness

1) Activate the menu item “Functions » Set Bright-
ness...”. The window “Set Brightness” appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Select the brightness desired from the list
“Brightness” (100 %, 75 %, 50 %, 25 %).

4) Click “OK” to confirm your entries, or click “Can-
cel” to cancel the procedure.

Once the transmission has been completed, a con-
firmation message will appear.

4.2.12.3 Changing the unit address (ID)

1) Activate the menu item “Functions » Set ID...".
The window “Set Sign ID” appears.

2) Select the future unit address from the list
“Sign ID” and click “OK” to confirm.

3) In the confirmation window, click “Yes” to con-
firm your selection, or click “No” to cancel the
procedure.

Once the transmission has been completed, a con-
firmation message will appear.

4.2.12.4 Deleting messages from the display

1) Activate the menu item “Functions » Delete
Page...”. The window “Delete Page” appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Tick the boxes next to the storage locations
(page A to page Z) whose messages are to be
deleted from the display.

4) Click “OK” to confirm your selections, or click
“Cancel” to cancel the procedure.

Once the transmission has been completed, a con-
firmation message will appear.

4.2.12.5 Deleting display programs from the display

1) Activate the menu item “Functions » Delete
Schedule...”. The window “Delete Schedule”
appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Tick the boxes next to the display programs that
are to be deleted from the display.

4) Click “OK” to confirm your selections, or click
“Cancel” to cancel the procedure.

Once the transmission has been completed, a con-
firmation message will appear.



4.2.12.6 Deleting all messages and programs

All the messages and display programs the user

may have saved can be deleted by means of the

following function.

1) Activate the menu item “Functions » Delete
All...”. The window “Delete All” appears.

2) Select the unit address from the list “Sign ID”
(“00” will select all units).

3) Click “OK” to confirm your selection, or click
“Cancel” to cancel the procedure.

Once the transmission has been completed, a con-

firmation message will appear.

5 Specifications
Number of LEDs: ....... 560 RGB LEDs
Power supply: .......... via power supply unit

provided and
connected to

230 V~/50 Hz
Dimensions: ........... 502 x 67 x 18 mm
Weight: . .............. 900¢g

Subject to technical modification.
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